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	Chapter 8
	Pr-Test / Post-Test Questions


Multiple Choice Questions

1.
How will you classify an unsorted list of customers’ ages and annual income? 

A)
information
B)
data
C)
market research
D)
records
E)
statistics
2.
Which of the following does not belong in a field?
A)
text
B)
numbers
C)
charts
D)
formulas
E)
functions
3.
When you are designing a worksheet list, what does the blue asterisk on the screen signify?

A)
it signifies the extent or size of the list range
B)
it identifies that the list range contains headers
C)
it signifies the range that you have selected
D)
it signifies the “insert row,” where you can enter a new record’s data
E)
it identifies that the list range contains footers

4.
Which of the following statements are accurate about data validation?
A)
data validation is necessary for ensuring data accuracy
B)
data validation is necessary for ensuring data completeness

C)
if your data validation requirements are not complex, Excel 2003's features will suffice
D)
A, B, and C are correct
E)
C is the correct answer
5.
What will return the current time into a worksheet list? 
A)
press [image: image1.png]


 + [image: image2.png]



B)
press [image: image3.png]


 + [image: image4.png]



C)
press [image: image5.png]


 + [image: image6.png]



D)
press [image: image7.png]
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E)
press [image: image9.png]


 + [image: image10.png]



6.
Which feature does not appear in the Data Form dialog box? 
A)
Add 
B)
Delete 
C)
Modify 
D)
Search 
E)
Update 
7.
Which option does not appear in the Data Form dialog box? 
A)
Move 
B)
Delete 
C)
New 
D)
Find Next 
E)
Find Prev 
8.
When a list contains a field column with formula expressions, what are the calculated results displayed as in the Data Form dialog box?
A)
Read, write and edit
B)
Write-only 
C)
Read and write 
D)
Read-only 
E)
Reusable 
9.
Which keys are used in a sort operation? 

A)
Primary sort key 

B)
Secondary sort key

C)
Tertiary sort key 

D)
only A and B are correct answers 

E)
Operation key 

10.
What approach is used in the Data Form dialog box to look for specific records? 
A)
Query-by-example 
B)
Search Engine 
C)
Find query 
D)
Global location 
E)
Locate Grid 
11.
The search pattern “??S?” possibly matches ________.
A)
Smallwood 
B)
Sick
C)
Smith 
D)
DISK
E)
Snyder 
12.
What cannot be done using the Print dialog box? 
A)
print a range selection

B)
print worksheet list

C)
print the active worksheet

D)
print the entire workbook

E)
you can do all of the above using the Print dialog box  
13.
Which of the following is the syntax for DAVERAGE? 
A)
=DAVERAGE(criteria_range, field_name, list_range) 
B)
=DAVERAGE(field_name, list_range, criteria_range) 
C)
=DAVERAGE(list_range, criteria_range, field_name) 
D)
=DAVERAGE(list_range, field_name, criteria_range) 
E)
=DAVERAGE(criteria_range, list_range, field_name) 
14.
What is the maximum number of conditions that the AutoFilter feature allows for filtering per field? 
A)
one 
B)
three 
C)
two 
D)
four 
E)
five 
15.
What is the DCOUNT function? 
A)
averages the values in a field or column whose records meet a specific criteria
B)
averages the values in a field or column whose records do not meet any particular criteria
C)
counts the number of cells that are not blank and whose records meet specific criteria
D)
counts the number of cells containing numbers whose records meet specific criteria
E)
counts the number of cells that are blank and whose records meet specific criteria
True/False Questions
16.
The AutoFilter feature enables you to filter a list by a maximum of six conditions per field.
17.
The COUNTIF and SUMIF let you apply criteria to determine whether to include cells in a calculation only if you use a criteria range.

18.
When your worksheet data is structured using summary functions, you cannot create outlines.

19.
It is not a good idea to store unrelated data on the same worksheet as a list.

20.
A criteria form is not an extension of a data form.
21.
Rather than grouping and collapsing rows and columns, you can use the delete command found under the Format menu.

Short Answer Questions
22.
Describe a data form.
23.
Why is the filtering technique used?

24.
Describe in brief the use of wildcards ‘*’ and ‘?’.

25.
Describe database functions, and their role.
Fill-in-the-Blank Questions
26.
Data is sorted and filtered in a list by using the _____________ button.
27.
If you are unsure of the proper spelling, _____________ characters can help you locate an entry.

28.
To make it easy for you to summarize the numerical and non-numerical data in a worksheet list, the ________ Row is used.
29.
The add-in program that leads you step-by-step through entering the SUMIF function and summing values in a list that meet a specific condition is called ____________________.
30.
When you group records together in a worksheet list and insert new rows for computing averages, sums, minimums, and maximums, it is called _______________.
31.
When you manipulate, organize, summarize, and present data in a form suitable for decision-making or further analysis, it becomes ___________.
32.
For ensuring data accuracy and completeness you must do ______________. 
33.
A phone book is an example of a worksheet _______, which is a collection of related information.
34.
Excel 2003 sorts a range into _____________ order, by default. 
35.
A worksheet range, usually appearing above the field header row that provides a few blank rows for inputting search conditions, is called an ______________ filter.
	Chapter 8

	Pre-Test / Post-Test Answer Key


Multiple Choice Questions
1. B (8.1: EX 432)
2. C (8.1.1: EX 433)
3. D (8.1.1: EX 433)
4. D (8.1: EX 432)
5. B (8.1.2 : EX 437)
6. E (8.1.3: EX 440)
7. A (8.1.3: EX 440)
8. D (8.1.3 : EX 440)
9. D (8.2.1: EX 448) 
10. A (8.1.4 : EX 442)
11. D (8.1.4: EX 442)
12. E (8.2.4: EX 457)
13. D (8.3.2: EX 468)
14. C (8.3.1:EX 463)
15. D (8.3.2: EX 468)
True/False Questions

16. False (8.4.2: EX 484)
17. False (8.3.3: EX 471)
18. False (8.3.1: EX 463)

19. True (8.1.1: EX 433)
20. False (8.1.4 :EX 442)
21. False (8.4.2: EX 484)

Short Answer Questions

22. A filter is a technique that limits the display of records in a worksheet list using a simple matching criterion. Similar to a pasta strainer that lets water through but not the pasta, a filter allows only some records to pass through for display. Filtering is an excellent way to find a subset of records to work with. (8.2.2: EX 451)

23. Excel 2003 provides a special tool for manipulating worksheet lists called a data form. A data form is a special dialog box that allows you to navigate, add, modify, delete, and search for records in a list. Unlike working directly with cells in the worksheet, a data form displays only a single record at a time. (8.1.3: EX 440)

24. Database functions let you perform mathematical and statistical calculations, such as summing or averaging values, on selected records in a list. Each of the database functions have the same arguments: list range, cell address, and criteria. Because most database functions begin with the letter “D,” they are sometimes called dFunctions.  (8.2.3: EX 454)
25. For fields containing text, wildcard characters can also help you locate an entry, especially if you are unsure of the proper spelling. Use the question mark (?) in place of a single character and the asterisk (*) to represent a group of characters. (8.1.4: EX 442)

Fill-in-the-Blank Questions
26. AutoFilter (8.1.1: EX 433)
27. wildcard (8.1.4: EX 442)
28. Total (8.2.3: EX 454)
29. Conditional Sum Wizard (8.3.2: EX 468)
30. Subtotaling (8.4.1: EX 478)

31. Information (8.1: EX 432)
32. Data validation (8.1: EX 432)
33. list (8.1.1: EX 433)
34. alphanumeric (8.2.1: EX 448)
35. advanced criteria (8.3.1: EX 463)
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	Chapter 8
	Managing Worksheet Lists


Overview

After completing this chapter, students will be able to understand basic list terminology, enter and find data in a worksheet list, sort and filter list information, query and extract data from a list, analyze a list using database functions, and summarize a list using subtotals.

Tips and Teaching Strategies

Highlight the fact that the hiding of data via filters does not delete the data.  A filter’s purpose is to display only what you are interested in and hide the rest (for a short time, generally).

The Conditional Sum Wizard (discussed in section 8.3.4) is an Excel add-in which may not be present on all machines.  Before assigning students to lab work or work at home, be sure to check the availability of this add-in.  The installation disk is needed to install and some students may not have access to this disk.

Prerequisites
This chapter presumes no previous database or list management experience. However, students must know how to perform basic worksheet editing commands, such as changing row heights and column widths and inserting and deleting rows and should also have completed Chapter 7 so that they are familiar with working in large worksheets and multiple-sheet workbooks
Section 8.1 – Creating Lists

In this module you learn how to design and define a worksheet list. You also learn how to enter data, navigate a list, and find specific information using Excel 2003’s Data Form tool. 

Section 8.1.1 – Defining a List

Feature:
To define a list

Method:
To define a worksheet list using the menu

SELECT: the range containing the desired list area

CHOOSE: Data ( List ( Create List 

To define a worksheet list using the right-click menu:

RIGHT-CLICK: a cell within the desired list area

CHOOSE: Create List
Notes:
None.

Section 8.1.2 – Entering Data into a List

Feature:
To enter data in a list and keyboard shortcuts

Method:
Various keyboard shortcuts are presented in this section, assisting in the entering of data into a list.  They include the following:

· Ctrl+; (semi-colon) – inserts the current time

· Ctrl+: (colon) – inserts the current date

· Ctrl+* - selects the active worksheet’s area

· Ctrl+arrow keys – moves the cell pointer to the top/bottom/start/end of the current record or field

· Alt+DownArrow – displays a drop-down list of values from other records (for this field) to make inserting a like value easier

Notes:
To increase your speed and efficiency, commit this lesson’s keystroke combinations to memory.

Section 8.1.3 – Navigating a List Using a Data Form

Feature:
To use a data form to manage and navigate a list

Method:
To display the data form, select any cell within the list area and then:

CHOOSE: Data ( Form

or
CLICK: List menu button
CHOOSE: Form

To work with a list using the data form:

CLICK: New command button to add a record

CLICK: Delete command button to delete the current record

CLICK: Find Next command button to view the next record

CLICK: Find Prev command button to view the previous record
Notes:
None.

Section 8.1.4 – Finding Data Using a Criteria Form

Feature:
To use the Criteria Form

Method:
A criteria form is simply an extension of a data form. When you click the Criteria command button in the Data Form dialog box, Excel 2003 switches the display to a blank form that you can use to enter search criteria.

To use the criteria search features of the Data Form dialog box:

Display the Data Form dialog box.

Move to the first record at the top of the list.

CLICK: Criteria command button

Specify the search criteria by filling in the blank criteria form.

CLICK: Find Next command button
Notes:
To construct more complex criteria expressions, use Excel 2003’s standard comparison operators: < (less than), <= (less than or equal to), > (greater than), >= (greater than or equal to), and <> (not equal to). For fields containing text, wildcard characters can also help you locate an entry.

Section 8.1.5 – Modifying a List’s Structure
Feature:
To resize a worksheet list

Method:
To resize a worksheet list:

DRAG: the resize handle in the bottom right-hand corner of the list range
Notes:
None.

Feature:
To insert a row or column in a worksheet list

Method:
To insert a row or column in a worksheet list:

SELECT: the desired row or column

CLICK: List menu button  on the List toolbar

CHOOSE: Insert ( Row 

or
CHOOSE: Insert ( Column
Notes:
None

Feature:
To delete a row or column in a worksheet list

Method:
To delete a row or column in a worksheet list:

SELECT: the desired row or column

CLICK: List menu button on the List toolbar

CHOOSE: Delete ( Row 

or
CHOOSE: Delete ( Column
Notes:
Excel 2003 worksheet lists have an auto-expansion feature. With auto-expansion, whatever you type into an empty row or column adjacent to the worksheet list will be incorporated into the list area automatically

Section 8.2 – Working with Lists
This module examines methods for efficiently and effectively printing and converting your list data and techniques for manipulating list data like sorting, filtering, and summarizing.

Section 8.2.1 – Sorting a List

Feature:
To sort a list using the AutoFilter drop-down list arrow

Method:
To sort a list using the AutoFilter drop-down list arrow:

CLICK: a cell within the worksheet list in order to make it active

CLICK: a field column’s AutoFilter drop-down list arrow 

CLICK: Sort Ascending

or
CLICK: Sort Descending
Notes:
None
_________________________________________________________________

Feature:
To perform a simple sort using one field

Method:
To perform a simple sort using one field:

SELECT: a cell in the field column you want sorted

CLICK: Sort Ascending button

or
CLICK: Sort Descending button
Notes:
None.

Feature:
To perform a complex sort using more than one field

Method:
To perform a complex sort using more than one field:

CHOOSE: Data ( Sort

or
CLICK: List menu button 

CHOOSE: Sort
Notes:
To sort dates or months using the Sort dialog window, use the Options… button to provide additional sorting criteria.

Section 8.2.2 – Filtering a List

Feature:
To use the AutoFilter tool to filter the display of data

Method:
To filter the data in a worksheet list:

CLICK: a cell within the worksheet list in order to make it active

CLICK: a field column’s AutoFilter drop-down list arrow

SELECT: a value or a custom filtering option
To toggle the display of the AutoFilter drop-down list arrows:

CHOOSE: Data ( Filter ( AutoFilter

To remove the filter and display all records:

CHOOSE: Data ( Filter ( Show All
Notes:
When a filtering criteria has been selected via the drop-down lists, the drop-down button is changed to a blue color, indicating a criteria item from that drop-down was selected and in effect.

Section 8.2.3 – Summarizing a List

Feature:
To summarize the information in a worksheet list

Method:
To display the Total Row in a worksheet list:

CLICK: a cell within the worksheet list in order to make it active 

CLICK: Toggle Total Row button on the List toolbar

To enter a summary calculation for a worksheet list:

CLICK: a cell within the Total Row

CLICK: drop-down arrow attached to the cell

SELECT: the desired summary function from the drop-down list

Notes:
The Total Row is specifically designed to make it easy for you to summarize the numerical and non-numerical data in a worksheet list.

Section 8.2.4 – Printing a List

Feature:
To print the results of a list

Method:
Data from a list can be printed like any other worksheet.  When sorting, filtering, and other list manipulation has been completed, the list can be configured for printing (and printed) via one of commands below.

CHOOSE the Page Setup menu item from the File menu to adjust the print options

CHOOSE the Page Break Preview menu item from the View menu to adjust the page breaks that will occur

CHOOSE the Print Preview menu item from the File menu to view the list on-screen as it will be printed

CHOOSE the Print menu item from the File menu

Notes:
None.

Section 8.2.5 – Converting Workbooks to Different File Formats
Feature:
To convert workbooks to different file formats
Method:
To convert a worksheet list into a normal range:

CLICK: List menu button on the List toolbar

or
CHOOSE: Data ( List 

CHOOSE: Convert to Range

To convert worksheet data to a different file format:

CHOOSE: File ( Save As

SELECT: a data format from the Save as type drop-down list box

CLICK: Save command button

Notes:
This feature is especially applicable to working with Excel 2003 worksheet lists.
Section 8.3 – Analyzing Lists

In this module, you learn to limit the display of records using multiple criteria, extract records to a different location in a worksheet, and summarize statistical data using a variety of database and list functions. These include the use of the Advance Filter, six database functions (DAVERGE, DSUM, DCOUNT, DCOUNTA, DMIN, and DMAX), two list-based functions (COUNTIF and SUMIF), as well as the Conditional Sum Wizard.

Section 8.3.1 – Querying Lists and Extracting Data

Feature:
To use an advanced filter to query the list

Method:
An Advanced Filter can be used to provide support for filters based upon more than two criteria.  Advanced Filters work in a similar manner to regular Filters, by hiding the records which don’t match the filtering criteria.

To set up an advanced criteria filter:

Insert three or four blank rows above the active worksheet list.

Copy the field header row to the top row in the new criteria range.

Input your search conditions on the rows immediately below the criteria header row.

CHOOSE: Data ( Filter ( Advanced Filter

Specify whether to filter the list in-place or extract records to another worksheet location. Then, select the required cell ranges.

CLICK: OK command button
Notes:
If you place conditions on the same row in the criteria range, the criteria is evaluated using a logical AND to combine the conditions. If your conditions appear on separate rows, the criteria are evaluated using a logical OR between the conditions.

Section 8.3.2 – Using Database and List Functions

Feature:
Database/list functions

Method:
Excel 2003’s database and list functions let you perform mathematical and statistical calculations, such as summing or averaging values, on selected records in a list.  The syntax and an explanation of these functions is shown below. 

=DAVERAGE(list_range, field_name, criteria_range)
– calculates the average for the specified field, across the list with the criteria applied.

=DCOUNT(list_range, field_name, criteria_range)
– counts the number of cells for the specified field, in the list with the criteria applied.

=DCOUNTA(list_range, field_name, criteria_range)
- counts the number of non-blank cells for the specified field, in the list with the criteria applied.

=DMAX(list_range, field_name, criteria_range)
 - calculates the maximum value for the specified field, in the list with the criteria applied.

=DMIN(list_range, field_name, criteria_range)
- calculates the minimum value for the specified field, in the list with the criteria applied.

=DSUM(list_range, field_name, criteria_range)
- calculates the sum of the values in the specified field, in the list with the criteria applied.

Notes:
Keep your range names as short as possible to make them easier to use and remember.

Section 8.3.3 – Using COUNTIF and SUMIF Functions

Feature:
To use the COUNTIF function

Method:
The COUNTIF function calculates the number of cells within a given range that meets a specified criterion.  The syntax for the function is: =COUNTIF(field_range, criteria), where field_range is the range of cells to count across and criteria is the criteria to apply to each cell (only those meeting the criteria will be counted).

Notes:
None.

Feature:
To use the  SUMIF function

Method:
The SUMIF function calculates the sum of a range of cells which correspond to a condition or criteria.  The syntax for the function is: =SUMIF(field_range, criteria, sum_range), where sum_range is the range which is summed provided that the specified criteria is met in the range of cells in field_range.

Notes:
None.

Section 8.3.4 – Using the Conditional Sum Wizard

Feature:
To use the Conditional Sum Wizard

Method:
The Conditional Sum Wizard is a wizard with the functionality of the SUMIF function.  The only difference between the two is the interface provided by the wizard.

To use the wizard, it must first be installed.  By default, the wizard is not installed when you install Excel.  

To install the Conditional Sum Wizard:
CHOOSE: Tools ( Add-Ins 

In the dialog window that appears, select the Conditional Sum Wizard item
CLICK: the OK button.  You’ll need the original Office installation CDROM to install the wizard.

Once complete, you can activate the wizard.

To launch the Conditional Sum Wizard:
CHOOSE: Tools ( Conditional Sum. 

Next, follow the wizard’s prompts to define the location of the list, the field to sum across, and the condition to apply to the summation.  

CLICK: the Add Condition button to apply the condition just defined.  You can now add additional conditions by repeating the process.  

CLICK: the Next > button and define where the results will appear.  

CLICK: the Finish button to complete the summation.

Notes:
None.

Section 8.4 – Using Subtotals and Outlines

This module describes two methods for summarizing data based on the level of worksheet detail displayed. First, creating subtotals in a worksheet automatically groups data, creates an outline, and computes summary calculations. Second, grouping and outlining data manually in a worksheet provides ultimate control over the level of column and row detail that you want to display in reports and charts. These techniques are especially helpful for organizing and summarizing data in large worksheet lists.

Section 8.4.1 – Creating Subtotals

Feature:
To create subtotals automatically in Excel 

Method:
Excel 2003 provides a way to create subtotals in a worksheet list using a single command. 





To add subtotals to a worksheet automatically:

Sort the list by the field for which you want to calculate subtotals.

SELECT: any cell in the worksheet list
CHOOSE: Data ( Subtotals

Specify the sort field that contains the groupings, the desired summary function to calculate, and the fields you want to subtotal.

Notes:
None.

Section 8.4.2 – Grouping Data Manually

Feature:
Manual grouping

Method:
To manually group a selection of columns or rows:

CHOOSE: Data ( Group and Outline ( Group
Notes:
None.

Feature:
Manual ungrouping

Method:
To ungroup a selection or remove an outline:

CHOOSE: Data ( Group and Outline ( Ungroup, or

CHOOSE: Data ( Group and Outline ( Clear Outline
Notes:
None.
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Answers to End-of-Chapter Review Questions

Chapter 8
Answers to End-Of-Chapter Review Questions

Short Answer

1. List five questions that you should ask yourself when determining if Excel 2003 is the proper software tool for storing list information. 

a.
How complicated are my data management tasks?
b.
How much data needs to be stored?
c.
How much redundant data is expected?
d.
How important is data validation?

e.
Will my application need to be controlled by programming code?

2. In a few short sentences, summarize the guidelines for creating a worksheet list.
The guidelines for creating a worksheet list include being mindful of how your lists will appear when printed. Although not necessary, you should try to create a new list on separate worksheet, without any extraneous or unrelated data, and name the worksheet using a one-word label. Also, place a formatted field header row at the top of the worksheet list that contains the field names. Lastly, do not insert or leave blank rows or columns in the worksheet list.

3.
What list management tasks can you perform using the Data Form and Criteria Form dialog boxes?
A data form can be used to enter, edit and delete list items.  Along with a criteria form, it can also be used to scroll through the list, locate entries, and filter information according to specific criteria.

4.
What are the two primary options for sorting a list?
Lists can be sorted in either Ascending or Descending order.

5.
What are wildcards? Provide an example of how you might use a wildcard character. 
Wildcards are special characters used when searching or filtering data.  These symbols take the place of a single character or a group of characters.  For example, to find all surnames beginning with the letter H, you can type H*.

6.
When would you choose an advanced criteria filter over using Excel 2003’s AutoFilter feature?
The advanced filter is used to specify multiple or complex filtering conditions or when you want to calculate summary statistics using Excel 2003’s database functions.

7.
What is the relationship of search logic (AND, OR) in a criteria range to the row placement of the search conditions?
When criteria are placed on the same row, the AND logic is used. When criteria are placed on separate rows, the OR logic is used.

8.
What are the two actions that you can perform using an advanced criteria filter? 
You can either filter the list in place or extract data from the list to copy to a new location in the same worksheet.

9.
What function does the Conditional Sum Wizard help you enter into a worksheet cell?
The Conditional Sum Wizard add-in program helps you to enter the SUMIF function.

10.
Name two summary functions that you can use to subtotal data in a worksheet. 
In the Subtotal dialog box, you can select from the following functions: SUM, COUNT, AVERAGE, MAX, MIN, PRODUCT, COUNT NUMS, STDDEV, STDDEVP, VAR, and VARP. Identifying two of these functions is adequate.

True/False

	1.
	F
	6.
	T

	2.
	T
	7.
	F

	3.
	T
	8.
	F

	4.
	F
	9.
	T

	5.
	F
	10.
	F


Multiple-Choice

	1.
	c
	6.
	a

	2.
	b
	7.
	c

	3.
	a
	8.
	b

	4.
	c
	9.
	b

	5.
	b
	10.
	d


WD_IM06.9

